DataInsight-Web
# Table of Contents

*DataInsight-Web* ................................................................................................................................. *i*

*Table of Contents* ................................................................................................................................... *i*

*Overview* .................................................................................................................................................. 2

  1. Documentation and Support .............................................................................................................. 2

*Finding Data* ......................................................................................................................................... 3

  1. Keyword Search ............................................................................................................................... 3
     - Basic Search ................................................................................................................................. 3
     - Advanced Search .......................................................................................................................... 4
  2. Category Search .............................................................................................................................. 5
     - Data Sources ............................................................................................................................... 5
     - Building a Category Search ................................................................................................ .......... 6

*Saving Data* .......................................................................................................................................... 9

  1. Workbooks ...................................................................................................................................... 9
     - Using the Context Menu for Workbooks ...................................................................................... 10
     - Working with Series in a Workbook ............................................................................................. 14

*Viewing Data* ..................................................................................................................................... 16

  1. Picking Columns To Display .......................................................................................................... 16
  2. Series Graph/Information Display .................................................................................................. 17
  3. Switching from the Series List to a Data Table .............................................................................. 18
     - Actions ....................................................................................................................................... 19

*Preferences* ....................................................................................................................................... 21

  1. Global Preferences and Workbook Settings ................................................................................ 23

*Exporting Data* ................................................................................................................................. 27

  1. Exporting to Excel ........................................................................................................................ 27
  2. Applying Functions ........................................................................................................................ 30
Overview

DataInsight-Web is a browser-based data navigation and retrieval tool, with desktop-class performance. You can use DataInsight-Web to:

- Find the series you need
- Save your series in workbooks
- View and pivot data on-screen
- Export data to Excel

Documentation and Support

For the most up-to-date information about DataInsight, and our business in general, check our website, www.globalinsight.com.

For telephone support: In the United States, contact the Client Resource Center at 1-800-933-3374. Outside of the United States, please contact your sales representative.

For email support, send your request to Support@globalinsight.com.
Finding Data

Use keyword and category search to find series to view, export, or store in a workbook.

Keyword Search

Use keyword search to find series based on a set of words or phrases, similar to using a search engine to find Web pages on the Internet.

Basic Search

To perform a keyword search, select **Keyword Search** in the left-hand side data source pane, type some keywords, and hit return or press Go. Series that match your keywords will appear in the main results area, right below where you typed your keywords.
Advanced Search

Advanced search allows you to specify additional criteria to be used in addition to any keywords. Clicking on Advanced will expand the options available to you.

Advanced search allows you to limit results to series that match certain criteria: **Data Source**, **Series Name**, **Frequency**, and **Bank** (which can be selected from a list).

To select multiple banks use **Shift+Click** and **Ctrl+Click** (or Command-Click on the Macintosh platform).
Category Search

Use category search to find series based on specific criteria such country, industry, concept, brand, or vehicle type.

Data Sources

Related series are grouped into "datagroups" or "categories" such as U.S. Regional, Global Economy, and Financial Markets. The actual categories available to you will depend on your specific Global Insight subscription.
Building a Category Search

To perform a category search:

1. Select a category (Global Economy in this example), and the Available Criteria will appear for the chosen category. Depending on the category you have selected, there may be several different criteria that can be specified, such as Geography, Concept, or Industry. In this example Geography and Concept are available.
2. Select your criteria by using checkboxes. As you make your selections they will appear to the right in **Selected Criteria** area. In this example three geographies have been selected: China, India, and Indonesia.

![Selected Criteria](image1.png)

3. Optionally, use can use the Frequency and Scenario buttons to further limit matching series. (Note that not all categories have the Scenario button).

![Frequency and Scenario](image2.png)

4. When you have finished selecting criteria, click **Go** to see your results.

![Go](image3.png)
### Finding Data

#### Category Search

<table>
<thead>
<tr>
<th>Geography</th>
<th>Concept</th>
<th>Unit</th>
<th>Series Type</th>
<th>Start Date</th>
<th>End Date</th>
<th>Last Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>China</td>
<td>Nominal Gross Domestic Product</td>
<td>Billion LCU</td>
<td>Global - Detailed Forecast</td>
<td>1970</td>
<td>2037</td>
<td>2007-08-21</td>
</tr>
<tr>
<td>China</td>
<td>Nominal GDP Per Capita</td>
<td>LCU/person</td>
<td>Global - Detailed Forecast</td>
<td>1970</td>
<td>2037</td>
<td>2007-08-21</td>
</tr>
<tr>
<td>India</td>
<td>Nominal GDP Per Capita</td>
<td>LCU/person</td>
<td>Global - Detailed Forecast</td>
<td>1970</td>
<td>2037</td>
<td>2007-09-11</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Nominal Gross Domestic Product</td>
<td>Trillion LCU</td>
<td>Global - Detailed Forecast</td>
<td>1970</td>
<td>2037</td>
<td>2007-08-21</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Nominal GDP Per Capita</td>
<td>LCU/person</td>
<td>Global - Detailed Forecast</td>
<td>1970</td>
<td>2037</td>
<td>2007-08-21</td>
</tr>
<tr>
<td>Japan</td>
<td>Nominal Gross Domestic Product</td>
<td>Trillion LCU</td>
<td>Global - Detailed Forecast</td>
<td>1956</td>
<td>2037</td>
<td>2007-09-11</td>
</tr>
<tr>
<td>Japan</td>
<td>Nominal GDP Per Capita</td>
<td>LCU/person</td>
<td>Global - Detailed Forecast</td>
<td>1956</td>
<td>2037</td>
<td>2007-09-11</td>
</tr>
</tbody>
</table>
Saving Data

Workbooks

Workbooks are containers you can create to save, organize, and manage series.

Once you have found series, you can save some, or all, in a workbook.

Select some series and click the Save Selected icon (or right-click on Save…) or, to save all, click the Save All icon (or right-click on Save All…).

The Browse Workbook window will show all of your existing workbooks (if any) and allow you to select an existing workbook as the destination for your series, or you can create a new workbook by clicking on the New button.

If you have clicked “New”, a new, untitled workbook will be added to your list of workbooks. The name of the new workbook will be highlighted and ready to be re-
named. Rename your workbook and click "OK" (or press "Enter") to save your series in the new workbook.

To select your workbook in the future, simply click on it in your list of workbooks.

Using the Context Menu for Workbooks

Right click on a workbook in your list of workbooks to display a context menu of actions you can perform on the selected workbook.
**Context Menu Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Removes the workbook and its contents completely. You will receive a confirmation window before removal. You can also select the workbook and use your delete key.</td>
</tr>
</tbody>
</table>

**Copy**

Creates a copy of your workbook, which will appear at the bottom of your list of workbooks.

**Rename**

Makes the name of the selected workbook editable.
Move  Moves a workbook to another place in your list of workbooks. You will see the Browse Workbook window; where you can select where you would like your workbook to appear. You can also rearrange your list of workbooks by placing workbooks directly where you would like them using drag-and-drop.

Export  Exports your series into Excel. Depending on your operating system and how your browser is configured, Excel may launch immediately, an Excel sheet may load directly in your browser, or you may see a "file download" window giving you the option to Open or Save the Excel document.
**Note:** If using Internet Explorer, your files by default may be saved in Internet Explorer's temporary internet files folder of Internet Explorer. You can use Internet Explorer's menu options of **Tools > Internet Options > General tab > Settings > Move Folder** to change the default location for file downloads.

**View Data Table**
Displays the Data Table page with the series data in it. This table is also accessible from within a workbook by clicking the "Data Table" tab.
Working with Series in a Workbook

Series in a workbook can be moved, copied, and deleted by drag-and-drop or by using the context menu (available by right-click). You can also use the Delete key to delete any selected series.

Note: Workbooks are limited to a maximum of 1,000 series.

Using the Context Menu for Series in a Workbook

To use the context menu for the series in a workbook, select one or more series and then right-click for the menu.

When you move or copy series using this menu, a Browse Workbooks dialog box appears for you to choose the target workbook from a list or create a new workbook as the target.
DataInsight-Web User Guide

Saving Data

Workbooks
Viewing Data

After you click on the **Search** button, the results of your category search will appear in the columns in the middle of the page.

There are many options available to control how data is formatted and presented. See the section on **Preferences** for more information.

The following sections will show you how to:

- Rearrange, add, or remove data columns using the **Columns** button.
- Select series to graph and view series information.
- View the series in a data table.

**Picking Columns To Display**

Use the **Columns** button, at the bottom of the page, to display the **Custom Columns** dialog where you can add, remove, and reorder the columns you would like displayed for your series. You can change the selected columns by drag-and-drop, and you can also double-click on a column to flip it from right to left or vice-versa.
To expand a column’s width, place your cursor on the line between the column headings slowly until it displays as a two-sided arrow (*shown in a red box below*), then drag the column to the desired size.

<table>
<thead>
<tr>
<th>Concept</th>
<th>Unit</th>
<th>Frequency</th>
<th>Start Date</th>
<th>End Date</th>
<th>Last Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Price of Imported Crude Oil</td>
<td>$/bbl</td>
<td>QUARTERLY</td>
<td>1974-01-01</td>
<td>2017-10-01</td>
<td>2007-03-13</td>
</tr>
<tr>
<td>Received by Refineries</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average Price of Imported Crude Oil</td>
<td>$/bbl</td>
<td>QUARTERLY</td>
<td>1974-01-01</td>
<td>2017-10-01</td>
<td>2007-03-13</td>
</tr>
<tr>
<td>Received by Refineries</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Series Graph/Information Display**

At the bottom left of your screen, there is a dual-purpose panel for displaying a graph or information for one or more series that you select in the results area.

- **Chart**: Displays a graph of the selected series (you can choose up to 5 series for your graph). Click on this chart to see a larger version, with an option to switch between bar and line chart types.

- **Information**: Displays information for the last series selected.
Switching from the Series List to a Data Table

The View Data Table option of the Workbook context menu displays the Data Table page in the selected workbook with the series data in it.

Alternately, you can click on the Data Table tab in the workbook to see the table.
## Actions

There are several actions you can take on series in a workbook:

<table>
<thead>
<tr>
<th>Button</th>
<th>What it does...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Series List</td>
<td>Exports the selected series of the open workbook to Excel.</td>
</tr>
<tr>
<td></td>
<td>Exports all series of the open workbook to Excel</td>
</tr>
<tr>
<td></td>
<td>![Image of Export Selected button]</td>
</tr>
<tr>
<td></td>
<td>![Image of Export All button]</td>
</tr>
<tr>
<td>Functions</td>
<td>Allows you to apply functions (such as percent change) to selected series.</td>
</tr>
</tbody>
</table>

See **Applying Functions** in the **Exporting Data** section for more information.
Data Table View

Exports the series of the open workbook to Excel and opens Excel when you choose the **Open** button.

Toggles the orientation of the table

**Values Down:**

<table>
<thead>
<tr>
<th>WEFA BANK NAME(S)</th>
<th>SERIESTYPE</th>
<th>START DATE</th>
<th>END DATE</th>
<th>LAST UPDATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>WEFA SERIES NAME</td>
<td>CEIC9BQ0DSSB.M</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DRT SERIES NAME</td>
<td>CEIC ASIA.D/CEIC9BQ0DSSB.M</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FREQUENCY</td>
<td>MONTHLY</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SHORT LABEL</td>
<td>Naphtha Crude Oil, Non-Refining Use, South East Asia (SE), Kilolitre</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AUG 2004</td>
<td>234.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SEP 2004</td>
<td>224.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OCT 2004</td>
<td>146.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nov 2004</td>
<td>137.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEC 2004</td>
<td>179.00</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Values Across:**

<table>
<thead>
<tr>
<th>WEFA BANK NAME(S)</th>
<th>SERIESTYPE</th>
<th>START DATE</th>
<th>END DATE</th>
<th>LAST UPDATE</th>
</tr>
</thead>
</table>

Opens a new, full-size window containing only the table.

When available, will group or ungroup the data values in your table.
Preferences

To have your data display look exactly the way you want it after it downloads, DataInsight-Web offers many options to customize the way your data will display and export. Options are available at a global level, where defaults can be specified for the entire application, as well as at the workbook level, where an individual workbook may have its own unique settings.

Use **Preferences** (in the upper-left of your browser) to set **global defaults** that apply by default across all DataInsight-Web functions.

Use a workbook's **Settings** button to specify **settings for one particular**, overriding any global default settings for that workbook.

Most options can be set at either the global or workbook level. Note that at the workbook level you can chose to use application defaults, or to use settings specific to a workbook.
Switching from the Series List to a Data Table
Global Preferences and Workbook Settings

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export</td>
<td>Style</td>
<td></td>
</tr>
</tbody>
</table>

**Fancy**
This style displays a table that has formatting applied to it to make it more attractive and easier to see the column and row headers. Results are grouped, with each "grouping item" having its own row header with the members of the group below it. (So if grouping is by country, there will be a row with the name of the country and the following rows will contain the series for that country.) Data that has "Data Edge" information associated with it will be displayed according to the **Highlight Forecast** selection of the **Format** tab.

**Plain**
This style is an Excel spreadsheet without formatting and is recommended when the sheet is being used programmatically or as the input to another process, where style information and grouping could be a problem. With plain style each "grouping item" does not appear on a row by itself (like in **Fancy**). Instead, the grouping items are repeated in their own column, so each row has this information.

**Note:** When series are exported directly from your results or the series list (not the data table) they are grouped according to the first column in the results. (So if first column is **Concept** the results will be grouped by concept).
In the data table series are grouped according to the "Group by" selector.

<table>
<thead>
<tr>
<th>Location</th>
<th>The cell location (row number and column number) where you would like the data to start in the generated Excel document.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Format</strong></td>
<td><strong>Orientation</strong></td>
</tr>
<tr>
<td><strong>Decimal Places</strong></td>
<td>Select the number of decimal places to be displayed.</td>
</tr>
</tbody>
</table>

**Note:** When exporting data, full values will be exported to Excel, this setting determines the format Excel will apply to—

---

Switching from the Series List to a Data Table
the data. Once in Excel data can be reformatted to show additional decimal places if needed.

**Display dates as**

For dates that do not pertain to a single calendar day, such as "2000 Q1" or "2000", select whether these dates should be passed to Excel as the start or end of the period in question.

Example: For 2001 Q1 data, export this to Excel as 1 Jan 2001 (start of period) or 31 Mar 2001 (end of period).

**Highlight Forecasts**

For data where a "data edge" is reported, this preference lets you display forecast values in the highlight color of your choice.

**Date Range**

Select the date range in a number of years, quarters, months or observations in the future and in the past. Note: This selects the date range relative to TODAY -- it does not try to determine the data edge of individual series.

**Custom**

**Start Date**

- First available value: Select to export timeseries data, beginning with the first observation of the data that exists in our database.

- Number of values before or after today: Enter the number of observations, years, quarters, or months to export, starting with today and going back into time for historical data or ahead into the future for forecast data.

- Number of values up to end date: Enter the number of observations, years, quarters, or months to export, going back into time from the end date you specify in the following
Fixed Date: Enter a start date or select it using the calendar tool provided.

**End Date**

- Last value: Select to export timeseries data, ending with the last observation of the data that exists in our database.
- Today: Select to use today’s date as the end date.
- Fixed date: Enter an end date or select it using the calendar tool provided.

**Number of values before or after today**: Enter the number of observations, years, quarters, or months to export, starting with today and going back into time for historical data or ahead into the future for forecast data.

Advanced

- **Default order for Category Search**: When ordering series by concept (by clicking on the column header to sort ascending or descending), the default behavior is to sort alphabetically. This control lets you change the sorting behavior so that sorting is not done alphabetically, but is done by the order of the concept in Available Criteria in category search.

For example, if concepts appear in category search in "Available Criteria" in this order -- Sales, Cost of Goods Sold, Gross Profit, Expenses, Net Profit -- this preference, when set for "Concept (Order in Tree)," will display results in this same order, not alphabetically.

- **Billing code**: An optional billing code, which is recorded during your data usage and can be used to track data usage for billing purposes, for those users that accrue data usage related charges.

- **Maximum number of results**: Select the maximum number of results, from 1,000 to 9,000, that will be returned by search.

Note that a workbook is limited to 1,000 series, so to export...
more than 1,000 series at a time, you must export from search results, and not from within a workbook. This also means it is not possible to save all of the results from a search that returns more than 1,000 series. (Only the first 1,000 results will be saved).
Exporting Data

Series can be exported into Excel quickly and easily from all areas of DataInsight-Web: keyword search, category search, and workbooks. There are a wide array of preferences to control the appearance and behavior of export, please see Preferences for more information.

The following sections will show you how to:
- Export some or all series data to Excel.
- Apply functions to timeseries.

Exporting to Excel

To export category search data or workbook data to Excel:

1. Select one series in the Series List by clicking on it or, to select multiple adjacent series, use Shift-click or, to select multiple non-adjacent series, use Ctrl-click.

2. Select either the Export Selected or Export All option.

3. Select Open or Save on the File Download dialog box that appears.
If you select **Open**, Excel will display a preformatted table that you can adjust using Excel functionality, and then print or save.

If you select **Save**, a **Save As** dialog box appears for you to save the workbook, after renaming it if necessary, to any location on your system. A Download Complete dialog will appear after the file saves.
Exporting Data

DataInsight-Web User Guide

Applying Functions
Applying Functions

You can apply a function directly to a series, replacing it, or you can create a new series (a new row) to hold the series with the function applied to it.

To apply a function to a series:

1. Select one or more series from the Series List:

2. Click on the Function button at the bottom of your screen and select a function.

3. (Optional) Un-select the Replace selection option if you want to see each series you selected repeated with the function applied to it as a separate row.